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About HTMLed Pro
HTMLed Pro is an authoring tool used    to create HTML documents for the World Wide Web.    It assumes
that you have some familiarity with Windows and a mouse. It also assumes that you have familiarity with 
the basic aspects of HTML, HyperText Markup Language.

Installation instructions for HTMLed Pro are contained in a separate booklet, which discusses:

System requirements
Setup and installation of HTMLed Pro
Learning to create your first document with HTMLed Pro

The HTMLed Pro User Manual discusses the technical aspects of using HTMLed Pro. Included are 
instructions for using:

Menus
Speedbars
HTML Page Builder

If your version of HTMLed Pro is accompanied by Internet Software Technologies HTML Tutorial, you will
find it to be an excellent resource guide to the more technical aspects of HTML authoring. 



Menus

HTMLed Pro allows you to quickly access HTML features through the use of intuitive menus.    

File Menu
Edit Menu
Element Menu
Flow Menu
List Menu
Link Menu
Entity Menu
Font Menu
Style Menu
Options Menu
Window Menu
Help Menu



File Menu
This menu performs actions such as opening and saving files.    HTMLed Pro allows you to save files in 
either MS-DOS or UNIX format.    MS-DOS    text files have a CR-LF (carriage return & line feed) pair at 
the end of each line.    UNIX text files have only a line feed character.    When opening a file, HTMLed Pro 
will attempt to determine which type of file it is, and open it in the appropriate mode. Also on the file menu 
is an option to save a file as plain text, without any HTML tags.    HTMLed Pro can Import RTF (Rich Text 
Format) files and convert them to HTML form. The option to "Test HTML Document"    will launch a 
browser program (such as Mosaic or Netscape) and pass the current file name to the program as a 
command-line parameter.    The path to this browser program must be configured in the Options|Setup 
dialog box. An additional feature available to users of Netscape is the ability to do Dynamic Data 
Exchange (DDE) with Netscape when using the Test facility.

The file menu options are:

New Save
New with Doc Template Save As DOS/Unix File
Open Save as Remote
Open Remote Save without HTML Tags
Open URL Test HTML Document
Import RTF Print
Insert File Print Setup
Close Exit



New
Opens a new document.

When you choose New, a dialog opens, giving you the options of including:

<HTML>..</HTML>
<BODY>..</BODY>
<HEAD>..</HEAD> 
Title
Author's Name and Date
URL
Comment

The result is the    HTML document:

<html>
<!--

Author: Jane Doe
Date:     8/31/95
URL:     http://www.ist.ca/htmledpro/index.html

HTMLed Pro page
-->
<head>
<base href="http://www.ist.ca/htmledpro/index.html">
<title>Document title</title>
</head>
<body>
</body>
</html>



New with Doc Template
Opens an existing template file (.htt) as a new, unnamed file.

Template files are useful when constructing documents of similar structure or content.    Several sample 
template files are included with HTMLed Pro, and you can easily modify these and save them as template
files (.htt) for later use.



Open
Opens an existing HTML file (.htm), a template file (.htt), or an ASCII text file (.txt)

If you are currently editing a document, the file being opened will be loaded into a separate window. 
HTMLed Pro will handle files of over 1 Mb in size.



Open Remote
Opens and retrieves a    file on a remote (UNIX) server.

Open Remote requires that you have a winsock.dll installed and that you have Internet access (dial-in 
SLIP/PPP, or dedicated). You will need to have access to a remote server on which you have an account 
which allows FTP (file transfer protocol) access, so will need to know the name of the FTP host machine, 
your username, and your password.

You can at any time enter and save a configuration name which includes the FTP host machine, the 
current username, the password, and the directory in use at the time when the configuration is saved. 
This will allow you to reconnect to the same location with a single click of a button. Additional options 
available include the facility to move UP a directory level (CDUP) and to change working directories by 
entering the directory path in a dialog (CWD). If a directory is selected and double clicked, you will change
to that directory. If a file is selected, it can be accessed using the Get File button, which will retrieve the 
file and place it in an editor window. If the file being retrieved is an image (binary) file, it should be 
transferred in Binary Mode. If you are behind a firewall, you may need to use passive mode (PASV) to 
retrieve the file. HTMLed Pro requires that you Logout of the remote server before editing the retrieved 
file, thus closing the connection. This frees up the resources of the remote machine and is good network 
etiquette.    

A single click of the Close button will also close the connection, after which the window should be closed 
by clicking Close a second time.    You should close connections immediately after transferring files or you
may find that the remote ftp server will time out and close the connection for you.



Open URL
Opens a file on a remote server using its URL (Uniform Resource Locator)

Open URL requires that you have a winsock.dll installed and that you have Internet access (dial-in 
SLIP/PPP, or dedicated).    You will be given a dialog into which you can enter the URL (Uniform Resource
Locator) of the HTML document you wish to retrieve. The HTML file will be retrieved and placed into an 
edit window in HTMLed pro.



Import RTF
Imports a Rich Text Format (RTF) file and converts it to HTML form.

The imported file is put into a new editing window.



Insert File
Inserts an existing file at the cursor position in the active (current) document.

To insert a file, position the caret in the current document where you want the new text to be placed, then 
select the menu option.    A dialog box will appear allowing you to select the file.



Close
Closes the current (active) document.

If any changes have occurred to the document, you are prompted to save them before the document is 
closed 



Save
Saves changes to the (named) document you have been working on. 

After you choose Save, the document will remain open so that you can continue to work on it



Save As DOS File
Save as UNIX File
Saves the current document in DOS or UNIX format.    

You can use the Save As option to save a new document or to save an existing document under a new 
name, with the original document being unchanged.    After you choose Save As, the document will remain
open so that you can continue to work on it. Save As DOS File saves the file in MSDOS format, while 
Save As UNIX File saves the file in UNIX format. In a DOS file, end-of-lines are represented by the 
carriage return-line feed (<CR><LF>) pair, while in a UNIX file, end-of-line is represented by a newline 
character (<LF>). The ASCII values of these characters are:      <CR> == #13,    <LF> == #10



Save as Remote
Saves a new or existing document to a remote server.

Save as Remote requires that you have a winsock.dll installed and that you have Internet access (dial-in 
SLIP/PPP, or dedicated). You will need to have access to a remote server on which you have an account 
which allows FTP (file transfer protocol) access,    so will need to know the name of the FTP host 
machine, your username, and your password.



Save without HTML Tags
Removes all HTML tags from the document and saves the file with .txt (default) extension.

If you have created a document for the World Wide Web and decide you want to publish it in some other 
format, you can use the Save without HTML Tags feature to strip the HTML markups.    Your document is 
then ready to be loaded into word processor or desktop publishing software.



Test HTML Document
Launches a preconfigured browser to test your documents. 

The browser used to test documents is configured from the menu item Options | Setup.    If you are using 
Netscape for a browser, HTMLed Pro will use DDE (Dynamic Data ExchangeI) to load the document.    
Using DDE avoids the problem of loading multiple instances of the browser.



Print
Prints one copy of the current document.

HTMLed Pro allows you to print the document in the currently active window using the Windows print 
system.    The Windows print system allows you to continue working while the document is being printed.



Print Setup
Selects a printer and sets printing options.

You can configure your printer from HTMLed Pro before printing your documents.    Your printer options 
depend on the driver you have loaded and the current default printer.    For installing and configuring 
printers, please consult your Windows and printer documentation.



Exit
Closes all open documents and quits HTMLed Pro. 

HTMLed Pro will prompt you to save files if there are any unsaved modified documents currently open 
before exiting.



Edit Menu 

The Edit menu contains options to select, cut, and paste text within and between documents, using the 
Windows Clipboard so you can cut and paste to other applications. The "Remove HTML Tags" option 
allows you to select a block of text and remove all the HTML tags from the selected text.

The Edit menu options are:

Undo Find
Repeat Last Markup Replace
Cut Find Next
Copy Remove HTML Tags
Paste Intelligent Tag Insert
Clear All Autoparagraph Format
Delete Convert Entities to Characters
Select All Convert Characters to Entities



Undo
Cancels your last editing or formatting action. 

Cancelling a formatting action involved the insertion of compound tags will remove just one of the tags. It 
may be necessary to apply undo twice to remove an inserted pair of tags. 



Repeat Last Markup
Repeats the last markup command.

When repetitively inserting HTML markups, you can repeat the last markup command by selecting the 
menu item or pressing CTRL+R.



Cut
Deletes text from a document and places it into the Windows Clipboard.

To cut text from a document, you must first select it with mouse or with SHIFT and the cursor keys, then 
select the Cut menu item or press CTRL+X.    The selected text will be removed from the document and 
you can paste it back into your document at another location or into another Windows program.    You can 
use copy to place text in the clipboard without removing it.



Copy
Copies highlighted text from a document into the Windows Clipboard while leaving the original 
document intact.

To copy text from a document, you must first select it with mouse or with SHIFT and the cursor keys, then 
select the Cut menu item or press CTRL+C.    You can then paste it back into your document at another 
location or into another Windows program.    You can use cut to move text in the clipboard, removing it 
from the current document.



Paste
Pastes a copy of the contents of the Windows Clipboard at the insertion point, or replaces 
highlighted text in the document

To paste text from the clipboard into your document, you must first position the caret where you want the 
text to be pasted using the cursor keys or the mouse.    To paste the text you can use the Paste menu 
item or CTRL+V.    You can use cut or copy to place text into the clipboard before pasting.    If text is 
selected when pasting, the selected text will be deleted and replaced by the text in the clipboard.



Clear All
Clears the contents of the current document.

Use with caution
This command deletes all of the text that is in the current document window.    While this is a quick way of 
starting a new document it is strongly recommended that you always the the New file menu option 
instead.



Delete
Deletes the selected text from a document, but does not place it into the Windows Clipboard.

Removes the selected text from a document, this action is identical to using the DELETE key on selected 
text.    You can use the mouse or SHIFT and the cursor keys to select text.



Select All
Selects all of the text in a document at once.

Quickly selects all of the text in the current document window.    You can then cut, copy and paste the 
whole document into another document or another Windows program.



Find
Finds the location of a given string of characters in a document.

If you are looking for a specific word in a document, you can use the HTMLed Pro Find feature to search 
for it.    You are given the option of matching whole words only and matching Case, as well as the option 
to begin the search in either the Up or Down direction from the insertion point.



Replace
Finds the location of a given string of characters in a document, with the ability to replace it with 
another string.

If you want to change the same word several times in a document, you can use the HTMLed Pro Replace
feature to perform an automatic search and replace.    You are given the option of matching whole words 
only and matching Case, as well as the option to begin the search in either the Up or Down direction from 
the insertion point.



Find Next
Repeats the last Find, searching for the next location in the document of the search string.

You can repeat a search for a word used in a previous search by selecting the Find Next menu option or 
pressing F3.



Remove HTML Tags
Removes HTML tags from the selected text.

If you want to remove HTML tags from text, you must select it first using the mouse or SHIFT and the 
cursor keys, then select the Remove HTML Tags menu item.    This feature is useful if you want to copy or
cut text to be pasted into a non-HTML program.



Intelligent Tag Insert
Allows the intelligent insertion of HTML tags.

The "Intelligent Tag Insert" allows you to insert text at the start, end, or both the start and end of lines in 
an HTML document.    You can select the lines to be affected by specifying a string that is either at the 
beginning or end, or that is contained in a line.    For example, you could insert <H1> and </H1> at the 
beginning and end of every line that ends with a colon (":").

Example:
Original text is
        Some heading:
        Blah blah blah...
        ...
        Some other heading:
        Blah blah blah again...

After Intelligent Tag insert
        <H1>Some heading:</H1>
        Blah blah blah...
        ...
        <H1>Some other heading:</H1>
        Blah blah blah again...



Autoparagraph Format
Inserts HTML paragraph tags <P> at the end of a section of text which is followed by a blank line. 

If text is selected, the text in the selected region will be examined. If no text is selected, only the current 
line will be considered. In all cases, you are given the option of confirming the insertion of paragraph tags 
or allowing it to happen automatically.



Convert Entities to Characters
Converts HTML entities (such as &copy;) to their corresponding character form (©)

When working with entities, it is sometimes difficult to read the source text.    Converting the entities to 
their character form can assist in editing the document.    This feature is especially useful if you want to 
select text for cutting and pasting in another document.



Convert Character to Entities
Converts characters (such as ©) to their corresponding entity form (&copy;)

When pasting text from other programs, you can occassionally insert illegal characters in your document 
that must be replaced by an HTML entity.    HTMLed Pro allows you to automatically convert a character 
from its current format into an HTML entity.



Element Menu 

The items on this menu insert various HTML markup tags in the document. 
Note that some tags, such as TITLE are 'containers', which means that they enclose the text to which 
they apply.    For this type of, tag, you should first select the text you want to be in the container, and then 
select the menu option (or button or shortcut key).    Other tags are single tags and will be inserted at the 
current cursor position.

The Element menu options are:

Form Designer Head
Table Designer Body
Title HTML
Banner Standard Document Outline
Division Insert Current Time
Comment



Form Designer

Allows you to design a drag-n-drop, fill-out form.

The HTMLed Pro Form designer allows you to easily design HTML forms using a intutitive graphical 
interface.    You can then edit the generated HTML source to fine tune your form.

The Form Designer uses a drag-n-drop metaphor for laying out and designing forms.    The HTML form 
objects that can be dragged onto the Form include: 

Text
Checkbox
RadioButton
TextArea
Password
Submit
Reset
Select



Table Designer 
Allows you to design an HTML table visually.

The HTMLed Pro Table Designer allows you to easily design HTML tables using a intutitive spreadsheet-
like graphical interface.    You can then edit the generated HTML source to fine tune your table.

When generating the table you can control visual aspects of the table by selecting the following options:

Number of Rows
Number of Columns
Column Headings
Row Headings
Caption and its position relative to the table
Cell padding and spacing
Border, with width option
Cells in the table can be given text values, as well as horizontal and vertical alignment values, 
and NoWrap. 

Tables are designed by selecting the number of rows and columns, selecting a table cell, and entering its 
contents. Entries for Column or Row Headings are entered using the right mouse button which brings up 
a dialog which allows the entry of header text, vertical and horizontal alignment parameters, and NoWrap 
option. Cells can be dynamically sized by positioning the cursor over the vertical or horizontal grid lines 
and dragging



Title
Makes the selected text the title of the document.

Encloses the selected text with <TITLE>..</TITLE> tags.    The enclosed text will usually be displayed in 
the caption bar of the browser and is used to name the document in browser bookmark lists.    World Wide
Web crawlers and search engines use the title text along with the URL to identify a document.



Banner
Makes the selected text a non-scrollable banner.

[HTML 3.0]
Encloses the selected text with <BANNER>..</BANNER> tags.    The HTML source enclosed by the 
<BANNER>..</BANNER> tags is displayed in a non-scrollable region in an HTML 3.0 compliant browser.



Division
Identifies the selected text as a particular type of container, such as an Abstract, Appendix, 
Chapter, or Section.

[HTML 3.0]
Encloses the selected text with <DIV class="containertype">..</DIV> tags, as well as offering options 
such as Alignment, Clear, NoWrap, and the use of the (optional) </DIV> tag.



Comment
Makes the selected text a comment.

Encloses the selected text with the comment tag <!--..-->.    HTML comments are not displayed in HTML 
browsers.



HEAD
Identifies the selected text as the Head of the document.

Encloses the selected text with <HEAD>..</HEAD> tags.



BODY (Background and Colors)
Identifies the selected text as the Body of the document.

Encloses the selected text with <BODY>..</BODY> tags.(</BODY> optional) and allows you to specify 
text and link colors, as well as a background color and a background image. 
[ HTML 3.0/ Netscape]



HTML
Indicates that the selected text is HTML.

Encloses the selected text with <HTML>..</HTML> tags.



Standard Document Outline
Includes a standard document outline with <html>..</html>, <head>..</head>, <body>..</body>

Deletes any selected text. Best used in an empty window.



Insert Current Time
Inserts the current date and time.

Inserts the current system time and date.    The system time is determined by your computers internal 
clock.    If it appears inaccurate, you can modify it with the Windows Control Panel.



Flow Menu 
This menu deals with the HTML tags involving the flow of text on a page

The Flow menu options are:

Horizontal Rule <HR> <P> with options
Line Break <BR> <HR> with options
Paragraph <P> No Break <NOBR>
End Paragraph Word Break <WBR>
Center



Horizontal Rule <HR>
Inserts a Horizontal Rule <HR> tag. 

The <HR> tag inserts a divider, usually a line or bar.



Line Break <BR>
Inserts a Line Break <BR> tag. 

This tag causes the browser to display text following it on a new line.



Paragraph <P>
Inserts a Paragraph <P> tag

Browsers may insert a blank line before or after a paragraph. The </P> is optional.    The text following a 
<P> tag can be altered by using additional Paragraph attributes defined in the HTML specification.

 



End Paragraph </P>
Inserts an End Paragraph </P> tag. See <P>.

The End Paragraph tag is optional.    When using paragraph attributes, including the </P> tag can improve
readability of the HTML source.



Center
Centers the selected text (Netscape)

Encloses selected text with <CENTER>..</CENTER> tags.    If configured in Options | Setup, the 
Netscape <CENTER>..</CENTER> option can be replaced with the HTML standard <P 
ALIGN="center">..</P>.



<P> with options
Inserts a Paragraph tag with options.

The HTML standard options available include:
 

Alignment (center, left, right, justify)
Clear (left, right, all)
Class (Abstract, Appendix, Chapter, Section)
NOWRAP
</P>



<HR> with options
Inserts a HardRule(horizontal) tag with options.

The HTML standard options include: 

Alignment (center, left, right)
Clear (left, right, all)
Size (integer 1..5)
Width (absolute pixels or %)
NOSHADE



No Break <NOBR>
Indicates that the selected text should not be subject to word breaks.

Encloses selected text with <NOBR>..</NOBR>



Word Break <WBR>
Indicates a place for a break to occur in a word, should the word need to be broken.

Inserts <WBR> at the insertion point.



List Menu 

These items will create various types of lists from the selected text. 

HTMLed Pro will operate on the selected text in the following manner - if there is no whitespace at the 
beginning of a line, a <LI> tag will be inserted.    If there is whitespace, it will be assumed that this line is 
part of the previous list item.

List available include Unordered List <UL>, Ordered List <OL>, Definition List <DL>, Menu, Directory, List
Item <LI>, Lists with markers Disk, Circle, Square; Definition Term <DT>, and Definition Item <DD>.



Link Menu 

These options pop up dialog boxes so you can enter the appropriate information to create links to HTML 
documents and images.

The Link menu options are:

Link to URL Make Link from URL
Anchor Base URL
Image ISINDEX
Embed OLE object MailTo



Link to URL
Creates a link to an URL (Uniform Resource Locator)

The Link to URL feature assists you in creating valid HTML anchor references.



Anchor
Makes the selected text into an anchor. <a name="mylink">..</a>

You can create targets for hypertext links in the body of a document by naming a group of text as an 
anchor.    To select the text use the mouse or SHIFT and the cursor keys, then select the Anchor menu 
option.    You will be prompted for a name.    The name should be meaningful and not too long.



Image
Used to create inline image references in a document.

The HTMLed Pro image feature assists you in building valid HTML inline image references.    The inline 
images will appear in a browser along with your document text.



Embed OLE object
Allows you to use    Object Linking and Embedding (Microsoft Windows)

[Windows Netscape Only]
The Embed OLE object feature allows you to generate the correct markup for including an OLE object in 
your HTML document.    As this is a Netscape enhancement and is VERY platform specific, discretion is 
advised.



Make Link from URL
If an URL is selected, a link to it is automatically created.

The Make Link from URL feature allows you to generate a hypertext link quickly from URLs already in 
your document.    To use this feature, select the URL text using the mouse or SHIFT and the cursor keys 
and select the Make Link from URL feature from the menu.    A dialog box will be displayed prompting you 
to enter the text that will be displayed as the link.



Base URL
Sets the base URL for the given document

The Base URL identifies the original or principle location of your document on the World Wide Web.    This
aides viewers in tracking down the source of duplicated documents.    A dialog box will be displayed, be 
prompting you for the URL. 



ISINDEX
Indicates that the document is indexed. 

The prompt used to access client information can be added, producing <isindex prompt="Enter request">



MailTo
Creates a mail reference to the specified e-mail address.

World Wide Web browsers often have the ability to interpret these links and send mail to the encoded e-
mail address.    Including mailto references in your documents is a great way to facilitate reader response.



Entity Menu 
HTML entities are representations of special characters, such as "&gt;" (without the quotes) which is a 
greater-than sign (">").    Entities are also used for other special characters such as foreign characters 
which are not part of the standard 7-bit ASCII character set.    

Entity by Character value
Allows for the entry of the numeric value associated with a given entity. 

Users enter the ASCII numeric value of a character and an entity is produced such as &#42;



Font Menu 
This menu allows you to apply various tags which affect the font used to display text.

Font Size Font size tag <font size=+4>..</font> [Netscape]
Base Font Size Basefont size 

<basefont size=3>..</basefont>
[Netscape]

</FONT> End font size tag </font> [Netscape]
</BASEFONT> End basefont size tag </basefont> [Netscape]
Bold Bold tag <b></b>
Italic Italic tag <i></i>
Underline Underline font tag <u></u> (not widely supported)
Fixed-Width Fixed-width (teletype) <tt></tt>
Strikethrough Strikethrough font <strike></strike> [HTML 3.0]
Big Big font    <big></big> [HTML 3.0]
Small Small font <small></small> [HTML 3.0]
Subscript Subscript font <sub></sub> [HTML 3.0]
Superscript Superscript font <sup></sup> [HTML 3.0]



Style Menu 
Allows the application of various styles to sections of text. 
Headings can be one of six styles, Heading 1 <H1>..</H1>    to Heading 6, <H6>..</H6>, in order of 
decreasing emphasis.

Blinking text <blink></blink> [Netscape]
Emphasized text <em></em>
Strong emphasis <strong></strong>
Code example <code></code>
Sequence of literals <samp></samp>
Variable name <var></var>
Keyboarded text <kbd></kbd>

Defining instance of a term <dfn></dfn> [HTML 3.0]
Citation <cite></cite> [HTML 3.0]
Short quotation <q></q> [HTML 3.0]
Author name <au></au> [HTML 3.0]
Persons name <person></person> [HTML 3.0]
Acronym <acronym></acronym> [HTML 3.0]
Abbreviation <abbrev></abbrev> [HTML 3.0]
Inserted text <ins></ins> [HTML 3.0]
Deleted text <del></del> [HTML 3.0]



Options Menu 
The Options menu gives access to the Setup dialog (where configuration options for HTMLed Pro are 
set), the Editor font dialog, and also offer selection of the    custom toolbars to be displayed.    

Setup - tabbed dialog box
Options
Paths
Speedbars
Colors
Keyboard
Quick Keys.

Editor Font



Options 
This dialog box is used to configure features of the editor. Options available are:

Word Wrap
Newline after Title and Headings
Use Actual Characters for Entities
Display Options Dialog for New Documents (see File | New)
Use Lowercase HTML tags
Convert .htm to .html for uploads and link dialogs (Remote Open/Save)
Never use <CENTER>    </CENTER>(Netscape feature), but replace with<P ALIGN="center">.. 
</P>
Maximize Windows when opening
Use Dynamic Data Exchange to make Netscape load files. This will pass the file directly to 
Netscape via the Test option and will not require that you use Netscapes    Reload option when a 
file has changed.



Paths
This dialog box is used to configure the directory paths for applications.    Information can be included for 

Program to test HTML files - a browser
Image Viewer - a viewer for .gif or .jpg images
Working Directory -    the working directory where documents will be stored



Speedbars
This dialog box is used to configure the display of the speedbars as well as their individual locations on 
the screen. 



Colors
This dialog box is used to select the colors which will be used within the editor for normal text, HTML tags,
character entities, and comments.



Keyboard
This dialog box is used to select any keyboard translations for a selected number of keys on the 
keyboard. Once you have selected a key, it will appear depressed and you can then enter the text which 
will be used whenever that key is pressed. Pressing the Shift button allows you to do keyboard 
translations for the shifted keys as well.



Quick Keys
This dialog box is used to select Quick Key combinations for quick entry of common text.



Editor Font
This dialog box is used to select the size and style font to be used in the editor.



Window Menu 
This menu contains options for tiling and cascading open windows, minimizing windows to icons, and 
closing all open windows.    A list of currently open windows in HTMLed Pro is also on this menu.

The Window menu has the following options:
Cascade
Tile
Arrange Icons
Minimize All
Close All



Cascade
Cascades the open windows



Tile
Tiles the open windows



Arrange Icons
Arrange the icons within the HTMLed Pro editor.



Minimize All
Minimize all open windows to icon form.



Close All
Close all open windows and the associated files.



Help Menu

This menu gives various help related topics, including the HTML Page Builder.

Contents
Gives the list of topics related to HTMLed Pro for which Help is available.

Search for Help on
Allows you to enter a word or select one from a list, and get help on that topic.

How to use Help
Describes the method of using Windows help.

HTML Page Builder
HTML Page Builder is a tool which is designed to help you quickly and easily design your own Home 
Page for the World Wide Web. 
You are asked a few simple questions and a page is built automatically for you. Options which can be 
easily included in the homepage are:

Title and Heading
Subheading
Horizontal (hard) Rule line after headings ?
Center headings ?
Include an image ? Center it ?
Text - describe yourself/provide information
Links to other pages

You are given the option to include a Title/Heading, as well as a subheading on screen 2.
If you click on the Finish button, the page will be generated, resulting in HTML code which is commented 
regarding the structures which are used.

<HTML>
<HEAD>
<!-- This is the header of the HTML document -->
<TITLE>This is a Header</TITLE>
</HEAD>
<BODY>
<!-- The body of the document begins here -->
<H1>This is a Header</H1>
<H2>What should I put as a subheader</H2>
<HR>
<!-- This tag specifies an image file to be displayed on the page -->
<P ALIGN=center>
<IMG SRC="star.gif">
</P>
<P>
<!-- This is a paragraph of text -->
This is a demo of HTMLed Pro's Homepage Builder
</P>



<HR>
<HR>
This page was generated by <A HREF="http://www.ist.ca/htmledpro">HTMLed Pro</A>
</BODY>
</HTML>

When viewed in a web browser, the page will appear as below.

This is a Header

What should I put as a subheader

This is a demo of HTMLed Pro's Homepage Builder

This page was generated by HTMLed Pro
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SpeedBars
All of the Speedbars include tooltips, which appear when the mouse cursor is over a button. The 
Speedbars allow access to menu options in quick, easy to use button-form.

Standard
The Standard Speedbar includes buttons for File operations New, Open, and Save, Edit operations Cut, 
Copy, and Paste, Undo, as well as some of the standard tags including <P>, <HR>, etc. The Test button 
allows the document to be tested via the configured browser

Common Tags
The Common Tags Speedbar includes tags for headers, list, and table operations.

Extended Characters
The Extended Characters Speedbar includes all of the Extended Characters
(non English). Extended characters can be entered in Entity form or as Actual characters (see Options | 
Setup)

Special Characters
The Special Characters Speedbar offers many special characters including the Copyright symbol, 
Registered Trademark symbol, as well as several fractions.
These    characters can be entered in Entity form or as Actual characters (see Options | Setup)

Custom Speedbar
The Custom Speedbar allows the user to configure up to 10 custom buttons. A right mouse click over a 
button will bring up a dialog. You can enter text to be placed on the face of the button, as well as an 
opening tag and an optional closing tag.

Custom buttons can be used as a mechanism to extend the editor to include new HTML constructs which 
may appear in future versions of the HTML specifications. They can also be used to hold quantities of text
which you may which to use on an ongoing basis. Each custom button is capable of holding up to 32k of 
text, though a button of that size will become unwieldy.




